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Preface

This User Guide has been implemented by Boot & Work, S.L. working
under the name Industrial Shields.

Purpose of the manual

The information contained in this manual can be used as a reference to operating, to
functions, and to the technical data of the signal modules, power supply modules and
interface modules.

Intended Audience

This User Guide is intended for the following audience:

Persons in charge of introducing automation devices.
Persons who design automation systems.
Persons who install or connect automation devices.

Persons who manage working automation installation.

& Warnings:

Unused pins should not be connected. Ignoring the directive may damage the
controller.

Improper use of this product may severely damage the controller.

Refer to the controller’s User Guide regarding wiring considerations.

Before using this product, it is the responsibility of the user to read the product’s User
Guide and all accompanying documentation.

Maintenance must be performed by qualified personnel familiarised with the
construction, operation, and hazards involved with the control.

Maintenance should be performed with the control out of operation and disconnected
from all sources of power.

Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.



Rev. 6: 26-09-2024

The Ardbox Family PLCs are Open Type Controllers. It is required that you install the
Ardbox PLC in a housing, cabinet, or electric control room. Entry to the housing,
cabinet, or electric control room should be limited to authorised personnel. Failure to
follow these installation requirements could result in severe personal injury and/or
property damage. Always follow these requirements when installing Ardbox family
PLCs.

In case of installation or maintenance of the Ardbox please follow the instructions
marked in the Installation and Maintenance section.

Do not disconnect equipment when a flammable or combustible atmosphere is
present. Disconnection of equipment when a flammable or combustible atmosphere is
present may cause a fire or explosion which could result in death, serious injury and/or
property damage.

Avertissements:

Les broches non utilisées ne doivent pas étre connectées. Ignorer la directive peut
endommager le contréleur.

Une utilisation incorrecte de ce produit peut endommager gravement le controleur.
Reportez-vous au Guide de [l'utilisateur du contréleur pour les considérations de
cablage.

Avant d’utiliser ce produit, il incombe a l'utilisateur de lire le Guide de I'utilisateur du
produit et la documentation qui 'accompagne.

La maintenance doit étre effectuée par personnel qualifié familiarisé avec la
fabrication, le fonctionnement et les dangers liés au contréleur.

La maintenance doit étre effectuée avec I'équipement hors service et déconnectée de
toutes les sources d'alimentation.

Faites attention lors de I'entretien des composants sensibles a |'électricité statique. Les
recommandations du fabricant pour ces composants doivent étre suivies.

Les automates de la famille Ardbox sont des contrbleurs de type ouvert. Il est
nécessaire d'installer I'automate Ardbox dans un boitier, une armoire ou une salle de
contréle électrique. L'accés au boitier, a I'armoire ou a la salle de commande
électrique doit étre limité au personnel autorisé. Le non-respect de ces exigences
d'installation peut entrainer des blessures graves et/ou des dommages matériels
importants. Respectez toujours ces exigences lors de l'installation des automates de Ia
famille Ardbox.

En cas d'installation ou de maintenance du Ardbox, veuillez suivre les instructions
indiquées dans la section Installation et Maintenance.

Ne débranchez pas I'équipement en présence d'une atmosphére inflammable ou
combustible. La déconnexion de I'équipement en présence d'une atmosphere
inflammable ou combustible peut provoquer un incendie ou une explosion pouvant
entrainer la mort, des blessures graves et/ou des dommages matériels.
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Application Considerations and Warranty

Read and Understand this Manual

Please read and understand this manual before using the product. Please consult your
comments or questions to Industrial Shields before using the product.

Application Consideration

THE PRODUCTS CONTAINED IN THIS DOCUMENT ARE NOT SAFETY RATED. THEY SHOULD NOT
BE RELIED UPON AS A SAFETY COMPONENT OR PROTECTIVE DEVICE FOR ENSURING SAFETY OF
PERSONS, AS THEY ARE NOT RATED OR DESIGNED FOR SUCH PURPOSES.

Please know and observe all prohibitions of use applicable to the products.

FOR AN APPLICATION INVOLVING SERIOUS RISK TO LIFE OR PROPERTY WITHOUT ENSURING
THAT THE SYSTEM AS A WHOLE HAS BEEN DESIGNED TO ADDRESS THE RISKS, NEVER USE THE
INDUSTRIAL SHIELDS PRODUCTS.

NEVER USE THE INDUSTRIAL SHIELDS PRODUCTS BEFORE THEY ARE PROPERLY RATED AND
INSTALLED FOR THE INTENDED USE WITHIN THE OVERALL EQUIPMENT OR SYSTEM.

Industrial Shields shall not be responsible for conformity with any codes, regulations or
standards that apply to the combination of products in the customer’s application or use of the
product.

The following are some examples of applications for which particular attention must be given.
This is not intended to be an exhaustive list of all possible uses of the products, nor is it
intended to imply that the uses may be suitable for the products:

e Systems, machines, and equipment that could present a risk to life or property.

o Nuclear energy control systems, combustion systems, railroad systems, aviation
systems, medical equipment, amusement machines, vehicles, safety equipment, and
installation subject to separate industry or government regulations.

e Qutdoor wuse, uses involving potential chemical contamination or electrical
interference, or conditions or uses not described in this document.

At the customer’s request, INDUSTRIAL SHIELDS will provide applicable third party certification
documents identifying ratings and limitations of use that apply to the products. This
information by itself is not sufficient for a complete determination of the suitability of the
products in combination with the system, machine, end product, or other application or use.



Rev. 6: 26-09-2024

Intended use of Industrial Shields products

Consider the following:

Industrial Shields products should only be used for the cases of application foreseen in the
catalogue and the associated technical documentation. If third-party products and components
are used, they must have been recommended or approved by Industrial Shields.

The correct and safe operation of the products requires that your transport, storage,
installation, assembly, operation and maintenance have been carried out in a correct manner. It
must respect the permissible ambient conditions. You should also follow the indications and
warnings that appear in the associated documentation.

The product / system dealt with in this documentation should only be handled or manipulated
by qualified personnel for the task entrusted and observing what is indicated in the
documentation corresponding to it, particularly the safety instructions and warnings included
in it. Due to their training and experience, qualified personnel are in a position to recognize
risks resulting from the handling or manipulation of such products / systems and to avoid
possible hazards.

Disclaimers

Weights and Dimensions

Dimensions and weights are nominal and they are not used for manufacturing purposes, even
when tolerances are shown.

Performance Data

The performance data given in this manual is provided as a guide for the user in determining
suitability and does not constitute a warranty. It may represent the result of INDUSTRIAL
SHIELDS’s test conditions, and the users most correlate it to actual application requirements.
Actual performance is subject to the INDUSTRIAL SHIELDS Warranty and Limitations of Liability.
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Errors and Omissions

The information in this document has been carefully checked and is believed to be accurate;
however, no responsibility is assumed for clerical, typographical, or proofreading errors, or
omissions.

Residual Risks

The control and drive components of an Industrial Shields PLC are approved for industrial and
commercial use in industrial line supplies. Their use in public line supplies requires a different
configuration and/or additional measures. These components may only be operated in closed
housings or in higher-level control cabinets with protective covers that are closed, and when all
of the protective devices are used. These components may only be handled by qualified and
trained technical personnel who are knowledgeable and observe all of the safety information
and instructions on the components and in the associated technical user documentation.
When carrying out a risk assessment of a machine in accordance with the EU Machinery
Directive, the machine manufacturer must consider the following residual risks associated with
the control and drive components of a PDS.

1. Unintentional movements of driven machine components during commissioning, operation,
maintenance, and repairs caused by, for example: — Hardware defects and/or software errors in
the sensors, controllers, actuators, and connection technology — Response times of the
controller and drive — Operating and/or ambient conditions not within the scope of the
specification — Condensation / conductive contamination — Parameterization, programming,
cabling, and installation errors — Use of radio devices / cellular phones in the immediate
vicinity of the controller — External influences / damage.

2. Exceptional temperatures as well as emissions of noise, particles, or gas caused by, for
example: — Component malfunctions — Software errors — Operating and/or ambient
conditions not within the scope of the specification — External influences / damage.

3. Hazardous shock voltages caused by, for example: — Component malfunctions — Influence of
electrostatic charging — Induction of voltages in moving motors — Operating and/or ambient
conditions not within the scope of the specification — Condensation / conductive
contamination — External influences / damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose a risk to
people with a pacemaker, implants or metal replacement joints, etc. if they are too close.

5. Release of environmental pollutants or emissions as a result of improper operation of the
system and/or failure to dispose of components safely and correctly.
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Warranty and Limitations of Liability

Warranty

Industrial Shields’s exclusive warranty is that the products are free from defects in materials
and workmanship for a period of one year (or other period if specified) from date of sale by
Industrial Shields.

INDUSTRIAL SHIELDS MAKES NO REPRESENTATION OR WARRANTY, EXPRESSED OR IMPLIED,
REGARDING MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR PARTICULAR PURPOSE
OF THE PRODUCTS. ANY BUYER OR USER ACKNOWLEDGES THAT THE BUYER OR USER ALONE
HAS DETERMINED THAT THE PRODUCTS WILL SUITABLY MEET THE REQUIREMENTS OF THEIR
INTENDED USE. INDUSTRIAL SHIELDS DISCLAIMS ALL OTHER WARRANTIES, EXPRESS OR
IMPLIED

Limitations of Liability

INDUSTRIAL SHIELDS SHALL NOT BE RESPONSIBLE FOR SPECIAL, INDIRECT, OR CONSEQUENTIAL
DAMAGES, LOSS OF PROFITS OR COMERCIAL LOSS IN ANY WAY CONNECTED WITH THE
PRODUCTS, WHETHER SUCH CLAIM IS BASED ON CONTRACT, WARRANTY, NEGLIGENCE, OR
STRICT LIABILITY.

IN NO EVENT SHALL INDUSTRIAL SHIELDS BE RESPONSIBLE FOR WARRANTY, REPAIR OR OTHER
CLAIMS REGARDING THE PRODUCTS UNLESS INDUSTRIAL SHIELDS’S ANALYSIS CONFIRMS THAT
THE PRODUCTS WERE PROPERLY HANDLED, STORED, INSTALLED, AND MAINTAINED AND NOT
SUBJECT TO CONTAMINATION, ABUSE, MISUSE, OR INAPPROPRIATE MODIFICATION OR REPAIR.
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1. GPRS Ardbox Family HF: General Features
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COMPACT PLC ARDUINO GPRS ARDBOX 201/0s Family LOG HF

PLUS
12 to 24Vdc Fuse protection (2.5A)
InPUt VOItage - Polarity protection
Input rated voltage 24Vdc
Rated Power 30W
| Max. 1.5A
Size 100x45x115
Clock Speed 16MHz
Flash Memory 32KB of which 4KB are used by bootloader
SRAM 2.5KB
EEPROM 1KB

Communications

I12C -- USB -- RS232 -- RS485

RS485

An/Dig Input 10bit

0 to 10Vdc
Input Impedance: 39K
Separated PCB ground
Rated Voltage: 10Vdc

*Check Section 15 for
digital inputs threshold

(0-10Vcce) 5 to 24Vdc :
| min: 2 to 12mA detection
Galvanic Isolation
Rated Voltage: 24 Vdc
* Interrupt isolated Input | m?nfozzti\qdz"m A 5 to 24Vdc
HS Galvanic Isolation Se alraTe"c]j' SgénAround
(24Vcce) Rated Voltage: 24Vdc P 9

Analog Output 8bit
(0-10Vcc)

0 to 10Vdc

I max: 20mA
Separated PCB ground
Rated Voltage: 10Vdc

Digital Isolated Output
(24Vcc)

5 to 24Vdc
I max: 70mA
Galvanic Isolation
Diode Protected for Relay
Rated Voltage: 24Vdc

Imax 24Vdc: 410mA

Digital Isolated Output
Relay

30Vdc / 250Vac
Galvanic Isolation
Diode protected for Relay

Imax: 3A (30Vdc)
Imax: 5A (250Vac)

PWM Isolated Output 8bit

5 to 24Vdc
I max: 70mA
Galvanic Isolation

PWM Isolated
Output 8bit

24V Diode Protected for Relay
(24vec) Rated Voltage: 24Vdc (24Vcce)
Expandability I2C — RS232 - RS485 - TTL
006001001200 Analog
Reference
006001001300 Relay

11
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2. Technical Specifications

2.1 General Specifications

Power supply
voltage

DC power supply

12 to 24Vdc _—

Operating
voltage range

DC power supply

11.4t0254Vdc ===

Power
consumption

DC power supply

30W max.

External
power supply

Power supply voltage

24Vdc _—-

Power supply output
capacity

700mA

Insulation resistance

20MQ min. at 500Vdc between the AC terminals and the protective ground
terminal.

Dielectric strength

2.300Vac at 50/ 60 Hz for one minute with a leakage current of 10mA max.
Between all the external AC terminals and the protective earth terminal.

Shock resistance

80m/s?in the X, Y and Z direction 2 times each.

Ambient temperature (operating)

0° to 60°C

Ambient humidity (operating)

10% to 90% (no condensation)

Ambient environment (operating)

With no corrosive gas

Ambient temperature (storage) -20° to 60°C
Power supply holding time 2ms min.
Weight 350g max.

2.2 Performance Specification

Arduino Board

ARDUINO LEONARDO

Control method

Stored program method

1/0 control method

Combination of the cyclic scan and immediate refresh processing methods.

Programming language

Microcontroller

Arduino IDE. Based on wiring (Wiring is an Open Source electronics platform
composed of a programming language. “similar to the C”).

http://arduino.cc/en/Tutorial/HomePage

ATmega32u4

Flash Memory 32KB of which 4KB are used by bootloader
Program capacity (SRAM) 2.5KB
EEPROM 1KB
Clock Speed 16MHz

12
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2.3 Symbology
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Table that includes all the symbology that is used in the serigraph of the GPRS Ardbox Family

HF+:
Svmbol Standard No. / Standard
y Standard Title Reference No. / Symbol Meaning
Symbol Title
IEC 60417 / , : .
I Graphical symbols 5031 / Direct Ind.lcates that. the equipment |§
HEE BN suitable for direct current only;
for use on Current . . ;
: to identify relevant terminals
equipment
IEC 60417 / Indicates that the equipment is
Graphical symbols , suitable for alternating current
N for use on 5032 / Alternating only; to identify relevant
) Current .
equipment terminals
IEC 60417 /
Graphical symbols 5130 / Pulse To identify the pontrol by which
for use on a pulse is started.
. General
equipment
IEC 60417 / To identify an earth (ground)
Graphical symbols terminal in cases where
for use on 5017 / Earth, neither the symbol 5018 nor
. Ground . o .
equipment 5019 is explicitly required.
IEC 60417 / : . .
Graphical symbols To identify the swﬂch by
: means of which the signal
for use on 5115 / Signal lamp . .
) lamp(s) is (are) switched on or
equipment

off.

Medical Devices

CE marking indicates that a
product complies with

Directive CE Marking licable E ;
93/42/EEC applicable uropean Union
regulations
ISO 7000/ Indi iall
Graphical symbols n |cates.a p(.)tentla.y .
f 0434B / hazardous situation which, if
or use on . . .
. Warning symbol not avoided, could result in
equipment ; g
death or serious injury
ISO 7000/
Grap;hlcal symbols 5036 / Dangerous To indicate hazards arising
or use on
X Voltage from dangerous voltages
equipment

13
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3. Precautions

Read this manual before attempting to use the ARDBOX 20 I/Os Family HF GPRS PLUS and
follow its descriptions for reference during operation.

3.1 Arduino Board

The ARDBOX 20 1/Os Family HF GPRS PLUS PLCs include Arduino Leonardo Board as controller.

3.2 Intended Audience

This manual is intended for technicians, which must have knowledge on electrical systems.

3.3 General Precautions

The user must operate Ardbox according to the performance specifications described in this
manual.

Before using ARDBOX 20 I/Os Family HF GPRS PLUS under different conditions from what has
been specified in this manual or integrating ARDBOX 20 I/Os Family HF GPRS PLUS to nuclear
control systems, railroad systems, aviation systems, vehicles, combustion systems, medical
equipment, amusement machines, safety equipment and other systems, machines, and
equipment that may have a serious influence on lives and property if used improperly, consult
your INDUSTRIAL SHIELDS representative. Ensure that the rating and performance
characteristics of Ardbox are sufficient for the systems, machines, and equipment, and be sure
to provide the systems, machines, and equipment double safety mechanisms. This manual
provides information for programming and operating the Ardbox.

3.4 Isolation Precautions

Description:

This equipment does not include galvanic isolation between the grounds of the different
systems. This means that if an external device or sensor that shares the same ground reference
(GND) with the system is connected, any potential difference between these grounds could
damage the connected components. To avoid issues with interference, ground loops, or
damage to external equipment, ensure that all connected devices share the same ground
reference or use systems with appropriate isolation.

Recommendations:

e Connection Review: Verify that all ground connections are properly made and that
there are no significant potential differences between them.

e Use of Isolation: Consider using galvanic isolators or isolation transformers if it is
necessary to connect equipment with different ground references.

14
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4. Software interface

Industrial Shields PLC are programmed using Arduino IDE, which is a software based on the C
language. They can also be programmed directly using C, but it is much easier working with
Arduino IDE, as it provides lots of useful libraries.

Industrial Shields provide a boards package for programming the PLCs, making it easier and
friendlier. It includes various facilities such as not having to define the pins, etc.

In order to install Industrial Shields boards, these are the steps that must be followed.
Requirements:

Arduino IDE 1.8.15 or above (recommended: 1.8.19).

Steps:

1. Open Arduino IDE and go to: “File -> Preferences” located in the top left corner.

Preferences X

Settings  Networl<

Sketchbool: location:

C:\Users\AlberfiDocuments\Arduino Browse
Editor language: English (English) ~ | (requires restart of Arduino)
Editor font size: 15

Interface scale: Automatic | 100 2%  (requires restart of Arduino)

Show verbose output during: compilation upload
Compiler warnings: None

[Jpisplay line numbers

[JEnable Code Folding

Verify code after upload

[Juse external editor

Check for updates on startup

Update sketch files to new extension on save (pde -> .ina)
Save when verifying or uploading

Additional Boards Manager URLs: htrp://apps.\ndusrr\a\sh\elds‘com/ma\n/ardu\nn/hnards/pad'aqe_mdusn'\alshle\ds_mde ﬁ

More preferences can be edited directly in the file
€ :\Users\Albert\AppData\ocal\Arduinol S\preferences. txt
(edit only when Arduino is not running)

Ok Cancel

2. In Additional Boards URLs write the following:

3. Press OK to save the changes.
4. Go to: Tools -> Board: ... -> Boards Manager

15
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5. Search for industrialshields.

€ Boards Manager x
4 Type Al ~ | industrialshields
industrialshields ~

Boards included in this package:
ARDBOX family, M-Duino family.
Cnline help

Mare info

~ | Install

Close

6. Click install (selecting the latest version).
Following this steps you will be able to use now the Industrial Shields Boards:

File Edit Sketch Help

Auto Format Ctr+T

Archive Sketch

sketch_oct19z2
void setup( Fix Encoding & Reload

/4 Put Yol pianage Libraries... Ctri+Shift+1
¥ Serial Monitor Ctrl+Shift+M
void loop() Serial Plotter Ctri+Shift+L
A oput yo
WIFIT01 / WIFININA Firmware Updater
K
Boar rdbox GPRS family" t 8 Boards Manager...
Model: "Ardbox Analog HF+ w/ HW RS-232 GPRS" >
N Arduino AVR Boards >
Industrial Shields boards > 5 Family
Industrial Shields ESP32 > Ardbox DALI family
Programmer: "Arduino as ISP" > © Ardbox GPRS family
Burn Bootloader Ardbox WIFI/BT family

Ardbox LoRa family
M-Duino family
M-Duino DALI family
M-Duino GPRS family
M-Duino LoRa family

M-Duino WiFI/BT family -

M-Duino WIFI/BT + GPRS family

Spartan family

16
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Once the Ardbox Family is selected, an extra option will appear on Tools:

- Select the correct Ardbox Family HF PLUS Board (Ardbox Analog HF+ w/HW RS-232
GPRS, Ardbox Analog HF+ w/HW RS-485 GPRS, Ardbox Relay HF+ w/HW RS-232 GPRS
or Ardbox Relay HF+ w/HW RS-485 GPRS) depending on your jumpers & switch
configuration.

File Edit Skatch Help

Auto Format CtrleT
Archive Sketch
sketch_oct19z

void setup(| FiXEnceding & Reload

/7 PUT ¥ panage Libraries... Crrl+shift+l
1 Serial Monitor Ctri+shift+n
void loop() Serial Plotter Ctrl+shiftrL
47 put yo
WiFi101 / WiFININA Firmware Updater
}
Board: "Ardbox GPRS family” >
Model: "Ardbox Analog HF+ w/ HW RS-232 GPRS" > | © Ardbox Analog HF+ w/ HW RS-232 GPRS
> | Ardbox Analog HF+ w/ HW RS-485 GPRS
Get Board Info Ardbox Relay HF+ wf HW RS-232 GPRS

Ardbox Relay HF+ wf HW RS-485 GPRS
Programmer: "Arduino as ISP"

Burn Bootloader

Also there are some examples of programming in File -> Examples -> Ardbox GPRS Family.

Furthermore there are some extra libraries that can be found in Industrial Shields GitHub:
https://github.com/Industrial-Shields/
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Connect USB port from PLC to PC.

NOTE:

Ardbox Family uses micro USB cable.

Open Arduino IDE interface:

How to connect PLC Arduino to PC

Select Industrial Shields boards -> Ardbox GPRS Family

Select the correct port.

& sketch_mar16a | Arduino 1.8.0
File Edit Sketch Tools Help

sketch_mar16

void

Y

void

/Y

setup
put ¥

loop(
put W

Auto Format

Archive Sketch

Fix Encoding & Reload
Serial Monitor

Serial Plotter

WiFi101 Firmware Updater

Board: "Ardbox family”

Inclustrial Shields: "Ardbox Analog”
Port

Get Board Info

Programmer: "Arduino as ISP"
Burn Bootloader

Cl+T

Ctrl +Shift+M
Cirl +Shift+L

V3

Serial ports
COM13 (Arduino Leonardo)

Rev. 6: 26-09-2024

18



Rev. 6: 26-09-2024

6. How to connect PLC to power supply

- Ardbox GPRS Family PLCs are 12-24Vdc supplied. IMPORTANT: The polarity IS NOT
REVERSIBLE!

- Make sure that the live and GND connector of the power supply match the PLC.

Make sure that the power supply mains output is not higher than 24Vdc.

— — — — — —

r POWER SUPPLY

Ve

GND

: 24 vde
L Joew
\

— — — — — —

POWER
l2 to 24Vdc

\
I
|
)

Suggested power suppliers

Compact DIN rail power supply. Assembled on 35mm
DIM Rail:

P— [*"

-12vdc / 24Vdc 32 27y "
254 : g@ [
30w S i

e .

4 I
Industrial Shields power supplies provide parallel 20w 20,9
operation, overvaltage protection, and overcurrent
protection. There is a LED inductor for power status, the L %
power supply is certified according to UL “

The standard, Part 1 of IEC 61010, sets the general safety requirements for the following types
of electrical devices and their accessories, regardless of where use of the device is intended.

The equipment must be powered from an external power source in accordance with IEC
61010-1, whose output is MBTS and is limited in power according to section 9.4 of IEC 61010-1.

WARNING: Once the equipment is installed inside an electrical cabinet, the MTBS cables of the
equipment must be separated from the dangerous voltage cables.
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7. Ardbox GPRS pinout

Rev. 6: 26-09-2024

10s Table
Analog Digital Isolated Digital Isolated Digital/Analogic
Model Reference Input Input Output Output Relay Output
ANALOG 006001001200 8 9 10 7 0
RELAY 006001001300 8 9 0 2 8

20
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8. Ardbox GPRS Family I/0O serigraphy

8.1 006001001200 Zone Connections

LEFT ZONE
]
LEFT ZONE
Ardbox Arduino _ Switch config*
Connector Pin Function . - (see section & for Communications
1 I8 ™ : configuration. Enabling Communications
A0.6' 3 Analog Out @5 5??; disables some 1/0s)
A0.5' 5 Analog Out a4 EEE
A0.4' 6 Analog Out @3 | feeh
A0.3' 9 Analog Out w2 [~y
A0.2' 10 Analog Out o
A0.1" 11 Analog Out —
AQ.0' 13 Analog Out we Analog Outputs pins
A04
Q0.9? 1 Digital Output A03
Q0.8* 0 Digital Output iy
Q0.7 7 Digital Output A00
Qo.6' 3 PWNM/digital Output G &
Q0.5 5 PWM/digital Output 208 —®
Q0.4 6 PWM/digital Output gg'g -
Q0.3 9 PWM/digital Output G W’"W . )
Q0.2 10 | PWMdigital Output w0 |ve Digital Qutputs pins
Q0.1 11 PWM/digital Output gg-g %
Q0.0 13 PWM/digital Output a0 gy
Q00 e
GNDCom —_—
GNDCOM GND Gy
i Power supply connectors
24VCOM = Power Supply GND | %
oay |72 (24Vdc — GND)

! See section 8 to enable these connections
2See section 9 to enable these connections
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RIGHT ZONE
Ardbox Connector ArdPg/no Function
in
A+ 4 - RS485(A)
B->4 - RS485(B)
Y+34 - RS485(Y)
z34 - RS485(2Z)
SCL-PIN3? 3 SCL(I12C)
SDA - RST GPRS? 2 SDA (12C) - RST GPRS
TX-RS232%4 1 -
RX-RS232% 4 0 -
GND - Ground
5V - 5Vout DC
RESET - RESET
NC - -
NC - -
NC - -
10.9 18 Analog/Digital Input
10.8 19 Analog/Digital Input
10.7 20 Analog/Digital Input
10.6 21 Analog/Digital Input
10.5 22 Analog/Digital Input
10.4 23 Analog/Digital Input
10.3% 8 Analog/Digital Input
10.2° 4 Analog/Digital Input
10.1 12 Digital Input
10.0° 2 Digital interrupt

HS*: Hardware Serial
SS*: Software Serial

Config switch *
(see section 8 for communications
configuration)

3 See section 8 to enable these connections
4 See section 9 to enable these connections

Input / Qutput

g

8%

WM

é =
i

4108/RS-485 DE

RS-485 DE/I0S
109/RS-485 RE
8 £33 Rs-485 RE/I09
£ 222 SpA-D2/100

SCL-D3/Q0.6

PR —

SCL-PIN3
S DA-PIN2

2
]
3
o

TX-PIN4
RX-PIN8

SPI

—0 e—
0 ~o—
o ~e—
o ~e—
o ~e—
o ~~e—
o ~e—
o ~e—
0™

Lo ~o—

GND
SV
RESET
SCK
MOSI
MISO

109
108
10.7
106
105
104
103
102
10.1

10.0

Power LED

Rev. 6: 26-09-2024

RIGHT ZONE

Switch config®

[see section & for Communications
configuration, Enabling Communications
disables some 1/0s)

Communication pins

Digital/Analog

Arduino Reset button
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8.2 006001001300 Relay Zone Connections

Left Zone
Arduino .
Ardbox Connector Pi Function
in
NC - -
NC - -
NC - -
RESET - RESET
5Vdc - 5V Output
GND - GND
RX-RS-232% 6 8 Serial/lRS232
TX-RS-232%6 4 Serial/RS232
SDA - RST GPRS 2 SDA- RESET GPRS
SCL-PIN35 3 SCL -SS
R1 10 Relay 1 Out
R2 9 Relay 2 Out
R3 6 Relay 3 Out
GND - GND
24V - -

HS*: Hardware Serial
SS*: Software Serial

> See section 8 to enable these connections
® See section 9 to enable these connections

i oF
NC
HD-FDw
RS/PIN3-SCL
10.0/PIN2-5DA

RE-RS4B85/104
10.4/RE-RS483
DE-RS485/10.5
LOS/DE-RS485

Misa
MOSI
SCK
|RESET
Ve
GND
RX

X
PIN2-5DA n
PIN3-SCL u

i T TR e

145

RS

Rev. 6: 26-09-2024

LEFT ZONE

Switch config*

[zee section 8 for Communications
configuration. Enabling Communications
disables some 1/0s)

Communication pins

Relay Outputs

Power supply connectors
{24Vdc — GND)
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Right Zone
Ardbox Arduino .
Connector Pin Function

B- - RS485
A+ - RS485

Z-/A0.1 11 (FD)* RS485/ Digital Output

Y+/A0.0 13 (FD)* RS485/ Digital Output
R4 5 Relay 4 Out
R5 3 Relay 5 Out
10.9 23 Analog/ Digital Input
10.8 22 Analog/ Digital Input
10.7 21 Analog/ Digital Input
10.6 20 Analog/ Digital Input
10.5 19 Analog/ Digital Input
10.4 18 Analog/ Digital Input
10.3 8 Digital Optoisolated Input
10.2 4 Digital Optoisolated Input
10.1 12 Digital Optoisolated Input
10.0 2 Digital Input / Interrupt
R6 7 Relay 6 Out
R7 0 Relay 7 Out
R8 1 Relay 8 Out

Rev. 6: 26-09-2024

I RIGHT ZONE
- 3 ~  RS-485 pins

Amnalog Output Pins

Relay Outputs

5 Diigi i
& O igital/ Analog Input pins
f [~

o e

2~

§ 1

=

g

11

!

85 Relay Outputs

2 % &

*Depending on the mode HD/FD the Y+/Z- Analog Output pins are enabled or disabled. See
section 9 to see the configurations.

Config switch *

|see section & for communications
configuration)

Input / Qutput

i
L

\\\
o
"
-\\\
S

q
hAf
- ‘T’”'\\
I
|

Power LED Arduino Reset button
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9. Switch configuration

9.1 006001001200 Analog Model General Switches Configuration

LEFT ZONE SWITCH
Communications and inputs/outputs can not work simultaneously.

LEFT ZONE OFF OoN
SWITCH OFF ON 10.8 / RS-485 DE
10.8 / RS-485 DE 10.8 RS-485 DE RS-485 DE / 10.8
RS-485 DE /10.8 RS-485 DE 10.8 10.9 / RS-485 RE
10.9 / RS-485 RE 10.9 RS-485 RE SRR EE e
RS-485 RE /10.9 RS-485 RE 10.9 GPRSRST/I0.0
SDA - GPRS RST /10.0 | SDA - GPRS 10.0 S
SCL-PIN3/ Q0.6 SCL-D3 Q0.6 OFF oN

6. 10.8 / RS-485 DE — If this switch is ON the RS-485 DE is activated, otherwise the 10.8 will be
activated.

5. RS-485 DE / 10.8 — If this switch is ON the 10.8 is activated, otherwise the RS-485 DE will be
activated.

Note* To work with RS-485 DE, switch number 6 at ON and number 5 at OFF.

4. 10.9 / RS-485 RE — If this switch is ON the RS-485 RE is activated, otherwise the 10.9 will be
activated.

3. RS-485 / 10.9 — If this switch is ON the 10.9 is activated, otherwise the RS-485 RE will be
activated.

Note* To work with RS-485 RE, switch number 4 at ON and number 3 at OFF.

2. GPRS RST / 10.0 — If this switch is ON the 10.0 is activated, otherwise the (12C) SDA - GPRS RST
will be activated.

1. SCL-D3 / Q0.6 — If this switch is ON the Q0.6 is activated, otherwise the (12C) SCL-D3 will be
activated.
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TOP ZONE SWITCH

Rev. 6: 26-09-2024

TOP ZONE

SWITCH ON OFF

Q0.8 Q0.8 RS*

RS* RS* Q0.8

Q0.9 Q0.9 RS*

RS* RS* Q0.9
1.
2.
3.
4.

ON

OFF

Q0.8
RS*
Q0.9
RS*

Q0.8 - If this switch is ON the Q0.8 is activated, otherwise the RS* will be activated.
RS* - If this switch is ON the RS* is activated, otherwise the Q0.8 will be activated.
Q0.9 - If this switch is ON the Q0.9 is activated, otherwise the RS*will be activated.
RS* - If this switch is ON the RS* is activated, otherwise the Q0.9 will be activated.

Note* RS * can be RS-485 or RS-232 depending on the jumper configuration you have

chosen. To work with RS*, switches number 1 and 3 at OFF and number 2 and 4 at ON.

RIGHT ZONE SWITCH

RIGHT ZONE

SWITCH ON OFF

HD / FD Half Duplex Full Duplex
Q0.6 DIGITAL (Q0.6) ANALOG (A0.6)
Q0.5 DIGITAL (Q0.5) ANALOG (A0.5)
Q0.4 DIGITAL (Q0.4) ANALOG (A0.4)
Q0.3 DIGITAL (Q0.3) ANALOG (A0.3)
Q0.2 DIGITAL (Q0.2) ANALOG (A0.2)
Q0.1 DIGITAL (Q0.1) ANALOG (A0.1)
Q0.0 DIGITAL (Q0.0) ANALOG (A0.0)

RIGHT ZONE.

ON

OFE

HD - FD*

Q0.6
Q0.5
Q0.4

Q0.3
Qo2
Qo1
Q0.0

ON

OFF

1. HD/FD — Choosing between Half/Full Duplex for the RS485 communication. In order to use
Full Dupley, it has to be considered the TOP ZONE and the JUMPER ZONE (see section 9).

2-8. Q0.X/A0.X — The right zone configures the outputs. If the switch is set to “ON” the Q0.X

will have the behaviour of a digital output. If it is set to “OFF” it will be analog.
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9.2 006001001300 Relay Model General Switches Configuration

LEFT ZONE SWITCH
Communications and inputs/outputs can not work simultaneously.

LEFT ZONE on OFF
SWITCH ON OFF
- NC
NC - - [ | HD* / FD*
HD/FD* Half Duplex | Full Duplex (|| R5/PIN3-SCL
R5 / Pin 3-SCL R5 Pin 3 - SCL | [10.0/ GPRS RST
GPRS -

10.0 / GPRS RST-SDA 10.0 SDA O lrErsmms na
RE-RS485 / 10.4 RE-RS485 10.4 (] [10.4 / RE-RS485
10.4 / RE-RS485 10.4 RE-RS485 [ | [DE-RS485/10.5

- 10.5 / DE-RS485

DE-RS485/10.5 DE-RS485 10.5

10.5 / DE-RS485 0.5 DE-RS485 o0 24

1. NC — Not Connected

2. HD/FD* — Choosing between Half/Full Duplex for the RS485 communication. In order to use
Full Duplex, it has to be considered the TOP ZONE and the JUMPER ZONE (see section 9).

3. R5 / Pin3-SCL — If this switch is ON the R5 is activated, otherwise the Pin3 - SCL will be
activated.

4. 10.0 / GPRS RST - SDA — If this switch is ON the 10.0 is activated, otherwise the GPRS RST -
SDA will be activated.

1. RE-RS485 / 10.4 — If this switch is ON the RE-RS485 is activated, otherwise the 10.4 will be
activated.
2. 10.4 / RE-RS485 — If this switch is ON the 10.4 is activated, otherwise the RE-RS485 will be
activated.

Note* To work with RS-485 RE, switch number 1 at ON and number 2 at OFF.

3. DE-RS485 / 10.5 — If this switch is ON the DE-RS485 is activated, otherwise the 10.5 will be
activated.

4. 10.5 / DE-RS485 — If this switch is ON the 10.5 is activated, otherwise the DE-RS485 will be

activated.

Note* To work with RS-485 DE, switch number 3 at ON and number 4 at OFF.
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TOP ZONE SWITCH
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ON

OFF

RS*
R8
RS*
R7*

TOP ZONE
SWITCH ON OFF
RS* RS* R8
RS R8 RS*
RS* RS* R7
R7 R7 RS*
1.
2.
3.
4,

RS* - If this switch is ON the RS* is activated, otherwise the R8 will be activated.
10.2- If this switch is ON the R8 is activated, otherwise the RS* will be activated.
RS* - If this switch is ON the RS* is activated, otherwise the R7 will be activated.
10.3 - If this switch is ON the R7 is activated, otherwise the RS* will be activated.

Note* RS * can be RS-485 or RS-232 depending on the jumper configuration you have
chosen. To work with RS*, switches number 1 and 3 at ON and number 2 and 4 at OFF.
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9.3 006001001200 Analog RS-232 and RS-485 Switch

Configuration
ANALOG TOP ZONE
SWITCH MODE
Q0.8 OFF
RS* ON
Q0.9 OFF
RS* ON

ON

OFF

Q0.8
RS*
Q0.9
RS*

RS* TOP ZONE: In order to enable the RS* protocol the TOP ZONE must be configured as it is
shown in the table.

Having this setup, the Q0.8 & Q0.9 are disabled.

1.
2.
3.
4.
ANALOG LEFT ZONE
Swrcn | o | s
10.8 / RS* DE OFF ON
RS*DE /10.8 ON OFF
10.9 / RS* RE OFF ON
RS*RE /10.9 ON OFF
SDA - GPRS RST
SCL-D3

Q0.8 - If this switch is ON the Q0.8 is activated, otherwise the RS* will be activated.
RS* - If this switch is ON the RS* is activated, otherwise the Q0.8 will be activated.
Q0.9 - If this switch is ON the Q0.9 is activated, otherwise the RS*will be activated.
RS* - If this switch is ON the RS* is activated, otherwise the Q0.9 will be activated.

RS* LEFT ZONE: In order to enable the RS* communication protocol it is necessary that the
switches of the left one are configured as it is shown in the table.

The ones marked with “-” mean that they do not affect the RS* communication protocol.
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9.4 006001001300 Relay RS-232 and RS-485 Switch

Configuration
RELAY TOP ZONE
SWITCH MODE
RS* ON
R8 OFF
RS* ON
R7 OFF

RS* TOP ZONE: In order to

the TOP ZONE must be configured as it is shown in the table.

Having this setup, the R7 & R8 are disabled.

ON

OFF

RS*
R8
RS*
R7*

1.
2.
3.
4.
RELAY LEFT ZONE
NC
HD/FD ON/OFF | ON/OFF
R5/Pin 3-SCL
10.0 / GPRS RST-SDA
RE-RS485/10.4 OFF ON
10.4 /| RE-RS485 ON OFF
DE-RS485/10.5 OFF ON
10.5 / DE-RS485 ON OFF

enable the RS* protocol

RS* - If this switch is ON the RS* is activated, otherwise the R8 will be activated.
R8 - If this switch is ON the R8 is activated. otherwise the RS* will be activated.
RS* - If this switch is ON the RS* is activated, otherwise the R7 will be activated.
R7 - If this switch is ON the R7 is activated, otherwise the RS* will be activated.

HD/FD: Choosing between Half Duplex or Full Duplex for the RS* communication. In order to
use Full Duplex, it has to be considered the TOP ZONE and the JUMPER ZONE (see section 9).

RS* LEFT ZONE: In order to enable the RS* communication protocol it is necessary that the
switches of the left zone are configured as it is shown in the table.

The ones marked with “-” mean that they do not affect the RS* communication protocol.
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9.5 006001001200 Analog I2C Switch Configuration

TOP ZONE LEFT ZONE
SWITCH MODE SWITCH MODE
Q0.8 - 10.8 / RS-485 DE -
RS* - RS-485 DE /10.8 -
Q0.9 - 10.9 / RS-485 RE -
RS* - RS-485 RE /10.9 -
SDA-GPRS RST/10.0 | OFF
SCL-D3/Q0.6 OFF

Rev. 6: 26-09-2024

12C: Enable SCL and SDA connections (direct Arduino pins) with configuration switches. 10.0 and
Q0.6 will not be available. In order to implement this communication a 4.7kQ pull-up resistor is

required.

The ones marked with “-” mean that they do not affect the 12C communication protocol.

9.6 006001001300 Relay I2C Switch Configuration

TOP ZONE LEFT ZONE
SWITCH MODE SWITCH MODE
RS* - NC -
R8 - HD / FD* -
RS* - R5/ Pin 3-SCL OFF
R7 - 10.0 / GPRS RST-SDA OFF

RE-RS485 / 104

10.4 / RE-RS485

DE-RS485/10.5

10.5 / DE-RS485

12C: Enable SCL and SDA connections (direct Arduino pins) with configuration switches. 10.0 and
R5 will not be available. In order to implement this communication a 4.7kQ pull-up resistor is

required.

The ones marked with “-” mean that they do not affect the 12C communication protocol.
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10. Jumper Configuration

10.1 006001001200 Analog General Jumper Configuration

JUMPER ZONE 1
This jumper makes the choice between connecting MAX232 to pins 0,1 of
LEFT RIGHT the Arduino Leonardo or with the MAX485. In order to use the R5-232
RS-485 RS-485 Hardware Serial protocol both RS-232 must be connected to the D1/D0. In
DO D1 order to use the R5-485 Hardware Serial protocol both RS-485 must be
RS-232 RS-232 connected to the D1/D0.
JUMPER ZONE 2
LEFT RIGHT This jumper zone makes the choice between connecting the inputs Q0.9,
Q0.8 to pins 4 and & of the Arduino Leonardo respectively, or connect the
Q0.9 Qo8 R5-232 ports to activate the Software Serial RS-232. In order to use the
D4 D8 inputs Q0.9, Q0.8 the jumper must be connected to the pins 4 and 8. So
RS-232 SS RS-232 SS Q0.9 must be connected with D4 and Q0.8 must be connected to DB.

*The jumpers that are not connected to the middle jumpers MUST NOT be Connected

anywhere.

11 33 11
o0 ' t o0
R5-485 R5-232 Digital

HARDWARE HARDWARE Output
SERIAL  SERIAL 0.8

Q8.5
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10.2 006001001300 Relay General Jumper Configuration

JUMPER ZONE 1

LEFT RIGHT
Y+ Z-
ENABLE ENABLE
A0.0 AO0.1

JUMPER ZONE 2

LEFT RIGHT
10.2 10.3
D4 D8
RS-232 RS232
JUMPER ZONE 3

DOWN UpP
RS-485 RS-485
DO D1
RS-232 RS-232

This jumper zone makes the selection between using the R5-485 Full Duplex
or the Analog Outputs. If it is wanted to use the R5-485 Full Duplex
communication protocol the Y+ must be connected to ENABLE, and Z- also
connected to ENABLE. If it is wanted to use the Analog Outputs, the AD.0
must be connected to ENABLE, and AD.1 also connected to ENABLE,

This jumper zone makes the choice between connecting the inputs Q0.9,
Q0.8 to pins 4 and 8 of the Arduino Leonardo respectively, or connect the
R5-232 ports to activate the Software Serial R5-232. In order to use the
inputs 0.9, Q0.8 the jumper must be connected to the pins 4 and 8. So
Q0.9 must be connected with D4 and Q0.8 must be connected to D8.

This jumper makes the choice between connecting MAX232 to pins 0,1 of
the Arduino Leonardo or with the MAX485, In order to use the R5-232
Hardware Serial protocol both RS-232 must be connected to the D1/D0. In
order to use the R5-485 Hardware Serial protocol both RS5-485 must be
connected to the D1/D0.

*The jumpers that are not connected to the middle jumpers MUST NOT be Connected

anywhere.

L X
RS-485
FULL

DUPLEX
Yo | 2

O
ARDWARE
000 .

OO i

o0
HARDWARE
PP i
oo 11 -

Digital RS-232 T
Inputs  SOFTWARE 33

SERTAL
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11. Hardware Serial RS-232 & RS-485 Configuration

11.1 006001001200 Analog Hardware Serial RS-485

In order to enable the Hardware Serial RS-485 the total configuration of the Ardbox Analog HF
PLUS will be:

Switch configuration:

TOP ZONE LEFT ZONE
ACTIVATED | MODE ACTIVATED MODE
SWITCH SWITCH

Q0.8 OFF DE-RS485 ON

RS* ON DE-RS485 OFF

Q0.9 OFF RE-RS485 ON

RS* ON RE-RS485 OFF
GPRSRST/10.0 -
SCL-PIN3/ Q0.6 -

Jumper configuration:

ZONE 1 ZONE 2
RS-485 Digital
HARDMARE Dutputs
SERIAL Qa8

Qa.9

® Available communication protocols:
o Hardware Serial RS-485.
o 12C *If 12C is active 10.0 & Q0.6 are disabled.
o TTL (SoftwareSerial)
o USB
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11.2 006001001200 Analog Hardware Serial RS-232

In order to enable the Hardware Serial RS-232 the total configuration of the Ardbox Analog HF

PLUS will be:

Switch configuration:

TOP ZONE LEFT ZONE
ACTIVATED | MODE ACTIVATED MODE
SWITCH SWITCH
Q0.8 OFF 10.8 OFF
RS* ON 10.8 ON
Q0.9 OFF 10.9 OFF
RS* ON 10.9 ON
GPRSRST/10.0 -
SCL-PIN3 / Q0.6 -
Jumper configuration:
ZONE 1 ZONE 2
R5-232 Digital
HARDWARE Outputs
SERTAL Qe.s
Qa.9

® Available communication protocols:
Hardware Serial RS-232.

o

@)
@)
O

12C
TTL
usB

MNote: The switches of the left
zone of the RS5-485 don't
interfere in the R5-232 HS. As
pins 0 & 1 are reserved for the
R5-232, the RS-485 is totally
disabled and there is no point
on configuring these switches
as R5-485 mode

*If 12C is active 10.0 & Q0.6 are disabled
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11.3006001001300 Relay Hardware Serial RS-485

In order to enable the Hardware Serial RS-485 the total configuration of the Ardbox Relay HF

PLUS will be:

Switch configuration:

TOP ZONE LEFT ZONE
ACTIVATED | MODE ACTIVATED MODE
SWITCH SWITCH
RS* ON NC -
R8 OFF HD/FD ON - OFF
RS* ON R5 / Pin 3-SCL -
R7 OFF 10.0 / GPRS RST -
RE-RS485 ON
RE-RS485 OFF
DE-RS485 ON
DE-RS485 OFF
Jumper configuration:
ZONE 1 ZONE 2
o0 t t
11 .
Outputs Inputs
AB.P I8.2
48.1 18.3

® Available communication protocols:
Hardware Serial RS-485.

o

@)
@)
@)

12C
TTL
usB

ZONE 3

o909 o

HARDWAR E

o9 P

*If 12C is active 10.0 & R5 are disabled
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11.4 006001001300 Relay Hardware Serial RS-232

In order to enable the Hardware Serial RS-232 the total configuration of the Ardbox Relay HF
PLUS will be:

Switch configuration:

TOP ZONE LEFT ZONE
ACTIVATED | MODE ACTIVATED MODE
SWITCH SWITCH

RS* ON NC -

R8 OFF HD / FD ON - OFF

RS* ON R5 / Pin 3-SCL -

R7 OFF 10.0 / GPRS RST -
10.4 OFF
10.4 ON
10.5 OFF
10.5 ON

Jumper configuration:
ZONE 1 ZONE 2 ZONE 3
o0
t t 000 .
o0

00® i

Analog

Outputs r‘i_ﬂ”-"’l
AB.B Inputs
A8.1 18.2

® Available communication protocols:
o Hardware Serial RS-232.

o 12C *If 12C is active 10.0 & R5 are disabled

o TTL

o USB
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12. Ardbox - Arduino I/Os 5V pins

The Ardbox has one of the Leonardo board pins available. This pin can be programmed
according to Arduino features such as 1/Os operating at 5V. As the pin is directly connected to
the Arduino Leonardo board they are not as well protected as the normal inputs. The pin is
mainly meant to be used as prototyping.

Ardbox terminal Arduino pin
SCL—Pin 3 3

*IMPORTANT: Do not connect the pin in the chart above to voltages higher than 5V. This
terminal provides direct access to the Leonardo board.

12.112C pins - SDA/SCL

The 12C protocol is meant to work in a pull-up configuration. The 12C pins in the Arduino
Leonardo are not pull-up, so in order to work with the 12C an external pull-up resistor is
required. If it is meant to work as a GPIO at 5V, the switches must be set as 12C, (section 8).

These pins are not established with a pull-up or a pull-down configuration. The state of these
pins is unknown. If these pins must be used they require a pull-up or a pull-down configuration.
The Arduino board allows the pins to be set in a pull-up configuration. If not it must be
established as an external pull-up or pull-down circuit in order to correctly work with these
pins.

12.2Pin 3

Pin 3 is only referred to the output Q0.6 for the Analog model and R5 for the Relay model. If
the switch configuration is in OFF position the Pin 3 will be available.

The pin is not established with a pull-up or a pull-down configuration. The state of the pin is
unknown. If the pin must be used, it requires a pull-up or a pull-down configuration. The
Arduino board allows the pin to be set in a pull-up configuration. If not it must be established
as an external pull-up or pull-down circuit in order to correctly work with Pin 3.
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The SIM800L module is the integrated module for the use of GPRS / GSM in this PLC. Its

principal features are:

Only works with 2G technology.

Commands).

SIM size: Micro SIM.

Quad-band 850/900/1800/1900MHz.

Can send / receive SMS messages.
Can send / receive GPRS data (TCP/IP, HTTP, MQTT).
Controlled by AT Commands (3GPP TS 27.0077, 27.005 and SIMCOM enhanced AT

Max. transmission speed: 85.6 Kbps.
Serial transmission speed: 1200 bps up to 115200 bps (Baud rate).

AT Command interface with transmission speed “automatic” detection.

When defining the pins in the program, take into account that the internal connections
between the SIM800L module and the Arduino Leonardo are the following:

Arduino Leonardo Pinout SIM800L Pinout
5vdc Ve
GND GND
MOSI (Pin 16) TxD
MISO (Pin 14) RxD
Pin 2 GPRS RESET

The GPRS / GSM protocol is always enabled as there are no switches that configure it. The
protocol uses the SPI pins of the equipment to be able to communicate and the Pin 2 for the

module reset.
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14. GPRS & GSM Programming Examples

14.1 How to use the GPRS Module

By following the steps on this post’, you will learn how to work with the GPRS Module that is
inside the PLC. A brief explanation about the examples provided by the Industrial Shields
libraries from GPRS is also done.

14.2 How to send SMS using GPRS from a GPRS Ardbox PLC

Two posts about how SMSs can be sent using GPRS have been written. The first one talks about
sending SMS when a temperature sensor reaches a certain threshold. You can find the post

here®.

The second one is about general features of the GPRS module and describes an example from
Adafruit FONA libraries. Check the link® to go to the post.

In the examples the communication with an M-Duino GPRS PLC is shown, but the process is
identical with the Ardbox models. Select the correct Ardbox board in the Arduino IDE while
doing any tutorial.

15. Digital inputs threshold detection

The Ardbox inputs have a minimum voltage threshold to reliably detect the signal when used
as digital input. The threshold value is different depending on the input type:

Input type Threshold voltage (V)
Digital input 3.7
Analog input 3.3

7 https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-use-gprs-module-158
8 https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-send-sms-using-gprs-from-an-mduino-403
S https://www.industrialshields.com/blog/arduino-industrial-1/post/how-to-send-sms-by-using-plc-controller-arduino-296
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16. I/0 technical details

Digital Output Waveform
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PWM Waveform
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Analog/Digital Input Turn-on
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17. Typical Connections
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18. Connector details

The connector inside the PLCs that mounts on the PCB is MC 0,5/10-G-2,5 THT — 1963502 from
Phoenix contact. MC0,5/10-G-2,5THT

For 1/O and power supply there is a FK-MC 0,5/10-ST-2,5 - 1881406 connector from Phoenix
contact. FK-MC 0,5/10-ST-2,5

Connection details:

Article reference MC 0,5/10-G-2,5
THT
Height 8,1mm
Pitch 2,5mm
Dimension 22,5mm
Pin dimensions 0,8x0,8mm
Pin spacing 2,50mm
Article reference FK-MC 0,5/10-ST-2,5
Rigid conduit section min. 0,14 mm?
Rigid conduit section max. 0,5 mm?
Flexible conduit section min. 0,14 mm?
Flexible conduit section max. 0,5 mm?
Conduit section AWG/kcmil min. 26
Conduit section AWG/kcmil max. 20
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19. ARDBOX Family Dimensions
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DI MISURA P(/ABS METHOD PC/ABS
Meccaniche  Redswivo o tuzionaclo sienameito KT8  WPo & Mechanical test Resstnce b tesis s o ATADEE W 1]
Resisioreo 0 tziones wturg ISTM D638 MPo 8 Tonsloshength ASTMDE3S MRy 8
Mungamerto o it KTM0ER % 9 Ul f ATHDE® % 5
Mhodulyin fesions STMDIR WP 7894 Flesing moduls MSTADIN MRy 7894
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Italtronic con operate ony change of the materials without being obliged fo forewam.
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20. Installation and Maintenance

Notes for installation:

- The installation position should be free from the following: dust or oil smoke,
conductive dust, corrosive or flammable gas, high temperature, condensation, and
rain.

- Besides, vibration and impact also affect the PLC normal operation and shorten its
lifespan; electric shock, fire or misact also damages the product. During drilling or
wiring, prevent the metal particles or wire segments from falling into the PLC casing,
which may cause fire, fault or misact.

- After the PLC installation, clean the ventilation duct to prevent blocking, which may
cause bad ventilation, or even fire, faults or misact.

- Do not online connect, plug or unplug cables, which are apt to cause electric shock or
damage the circuit. Installation and wire connection must be firm and reliable. Poor
connection could cause misact.

- Use shielded twisted pairs for the 1/O of high frequency signal and analog signal to
improve system IMS.

The installation environment should be free from dust, oil smoke, conductive particles,
corrosive or flammable gases, high temperature, condensation, and rain.

Besides, vibration and impact also affect the PLC normal operation and shorten its lifespan.
It is recommended to install the PLC, together with the matching switches and contactors,
in a dedicated electric cabinet and keep the cabinet ventilated. If the location has high
ambient temperature or heat generating equipment nearby, install forced convection
devices on top or sides of the cabinet to avoid over-temperature. During drilling or wiring,
prevent the metal particles or wire segments from falling into the PLC casing, which may
cause fire, fault or misact. After the PLC installation, clean the ventilation duct to prevent
blocking, which may cause bad ventilation, or even fire, faults or misact.

The only way to disconnect the equipment from the electrical network is by removing the
connectors that feed the equipment. Once installed in the electrical cabinet it is very
important to ensure the power connectors for proper operation.

Separate the ARDBOX 20 I/Os Family HF PLUS from heat, high voltage and electrical
noise:

Always separate the devices that generate high voltage and high electrical noise from the
ARDBOX 20 1/Os Family HF PLUS. When configuring the layout of the ARDBOX 20 I/Os
Family HF PLUS inside your panel, consider the heat-generating devices and locate the
electronic-type devices in the cooler areas of your cabinet. Reducing the exposure to a
high-temperature environment will extend the operating life of any electronic device.
Consider also the routing of the wiring for the devices in the electric cabinet. Avoid placing
low-voltage signal wires and communications cables in the same tray with AC power wiring
and high energy, rapidly-switched DC wiring.
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Provide adequate clearance for cooling and wiring ARDBOX 20 1/Os Family HF PLUS. Is designed
for natural convection cooling. For proper cooling, you must provide a clearance of at least
25cm above and below the devices. Also, allow at least 25cm of depth between the front of the
modules and the inside of the enclosure.

Notes for maintenance:

A well-planned and executed maintenance program is essential to the satisfactory operation of
solid-state electrical equipment. The kind and frequency of the maintenance operation will
vary with the kind and complexity of the equipment as well as with the nature of the operating
conditions. Maintenance recommendations of the manufacturer or appropriate product
standards should be followed.

The following factors should be considered when formulating a maintenance program:

- Maintenance must be performed by qualified personnel familiar with the construction,
operation, and hazards involved with the control.

- Maintenance should be performed with the control out of operation and disconnected
from all sources of power.

- Care should be taken when servicing electrostatic sensitive components. The
manufacturer's recommendations for these components should be followed.

- Ventilation passages should be kept open. If the equipment depends upon auxiliary
cooling, e.g., air, water, or oil, periodic inspection (with filter replacement when
necessary) should be made of these systems.

- The means employed for grounding or insulating the equipment from ground should
be checked to assure its integrity.

- Accumulations of dust and dirt on all parts, including on semiconductor heat sinks,
should be removed according to the manufacturer's instructions, if provided;
otherwise, the manufacturer should be consulted. Care must be taken to avoid
damaging any delicate components and to avoid displacing dust, dirt, or debris in a way
that permits it to enter or settle into parts of the control equipment.

- Enclosures should be inspected for evidence of deterioration. Accumulated dust and
dirt should be removed from the top of the enclosures before opening doors or
removing covers.

- Certain hazardous materials removed as part of maintenance or repair procedure (e.g.,
polychlorinated biphenyls (PCBs) found in some liquid filled capacitors) must be
disposed of as described in Federal regulations.

Safety rules for maintenance personnel

Consider the following steps to follow. A false manoeuvre could be the cause of an
accident or material damage.

Do not disassemble or modify the modules. This could lead to breakdowns or
malfunctions and could lead to injuries or fire.

- All types of radio communication devices, including mobile phones and personal
handy-phone systems (PHS), must be kept more than 25cm away from the PLC in all
directions. Failure to observe this precaution exposes malfunctions caused by excess
temperature.

- Disconnect the external power supply of the system (on all phases) before connecting
or disconnecting a module. Failure to observe this precaution may cause faults or
malfunctions of the module.
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- Tighten the screws of the terminal ports and the screws of the connectors within the
prescribed tightening torque. Insufficient tightening can lead to loose parts or wires
and cause malfunctions. Excessive tightening can damage the screws and / or the
module, with the risk of falling, short circuits and malfunctions.

- Before handling a module, dispose of the electrostatic charge accumulated by the
human body by touching a suitable conductive object. Failure to observe this
precaution may cause faults or malfunctions of the module.

Repair note:

If the equipment is suitable to be repaired, it must be verified that the equipment
remains in a safe state after repair.
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21. Revision Table

Revision Number Date Changes
0 30/08/2019 First implementation
1 04/03/2020 Second implementation
2 19/10/2022 Family Implementation
3 11/03/2024 Added section 15 “Digital inputs threshold detection”
4 13/03/2024 RS* Switches Revision
5 21/03/2024 Section 8.2 Digital inputs fix
6 26/09/2024 Added section 3.4 (“Isolation Precautions”)

About Industrial Shields:

Direction: Cami del Grau, 25

Zip/Postal Code: 08272

City: Sant Fruitds de Bages (Barcelona)

Country: Spain

Telephone: (+34) 938 760 191 / (+34) 635693 611
Mail: industrialshields@industrialshields.com
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